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OBJECTIVES
Throughout this Getting Started Guide, you will:

• Create an account on iDigi.com

• Set up and configure your ConnectPort X4 gateway

• Set up and configure your Drop-in Mesh Network

• Install the Digi ESP for Python Development Environment

• Run your first iDigi Dia application

Drop-in networking
As an integral part of the Drop-in Networking strategy, the Python development environment is 
incorporated by Digi into each ConnectPort X4 Gateway. Digi's integration of the open Python 
scripting language provides customers a truly open standard for complete control over 
connections to devices, manipulation of data, and event-based actions. For more information 
about the Digi Python custom development platform, visit our Python portal today at:

http://www.digi.com/technology/drop-in-networking/pdr.jsp

iDigi Dia
Also available is a device connection application called iDigi Dia (Device Integration 
Application). iDigi Dia software runs on the Digi family of gateway devices. Dia simplifies 
developing custom applications for remote monitoring and sensor networking. Dia is written in 
the Python programming language and can easily be extended to accommodate additional 
requirements. Dia can be executed on a PC for prototyping when a suitable Python 2.4 
interpreter is available.
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QUESTIONS?
For technical assistance with your Drop-in Network, call:

1-800-903-8430 (US Only)

Digi contact numbers outside US

Country Toll Free Number

Argentina 00-800-3444-3666

Australia 0011-800-3444-3666

Brazil 0021-800-3444-3666

China North 00-800-3444-3666

China South 00-800-3444-3666

France 00-800-3444-3666

Germany 00-800-3444-3666

Hong Kong 001-800-3444-3666

India 000-800-100-3383

Israel 00-800-3444-3666

Italy 00-800-3444-3666

Japan For calls from KDD fixed land-line phones: 010-800-3444-3666

From KDD public and mobile phones: 001-010-800-3444-3666

For non-KDD phones: 122-001-010-800-3444-3666

Korea 002-800-3444-3666

Mexico 001-800-903-8430

Netherlands 00-800-3444-3666

New Zealand 00-800-3444-3666

South Thailand 001-800-3444-3666

Spain 00-800-3444-3666

United Kingdom 00-800-3444-3666
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Starter Kit components, requirements, and resources

Kit components

The following items are not pictured above but are included in the kit:

• DB-9 Serial cable

• 9V Battery

• 9V Battery Adapter cable

Power Supply with
AC Power Cord

ConnectPort X4
Gateway

Wall Router

XBIB-U-DEV USB 
Interface Board USB cable

Ethernet 
crossover cable

XBIB-R-DEV RS232 
Interface Board

Module with integrated
 wire antenna

Power
adapter

Null Modem 
adapter

Loopback 
adapter (MEI)

XBee and RPSMA antenna

ConnectPort X4
Gateway antenna

Important!
Please read me first

Green document
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System Requirements
To run the kit, you will also need: 

PC running Microsoft Windows XP, Vista or Windows 7

Web Browser Requirements

Microsoft Internet Explorer 7.0 or newer

Google Chrome 4.0 or newer

Mozilla Firefox 3.0 or newer

Java Requirements 

Java Runtime Environment (JRE) 1.6 or newer

Additional Requirements 
This Getting Start Guide assumes a scenario where there are no other 
XBee wireless devices in the network/area other than the ones provided 
with this kit.

Resources
The following downloads are available at  www.digi.com/idigi_prof_zb   

Downloads • USB Development Board Windows Driver

• Digi Device Discovery Application 

• Digi Python Development Environment

Documentation • iDigi Dia Getting Started Guide

• iDigi Dia Developer's Guide

• iDigi Web Services Getting Started Guide 

• iDigi.com Web Services and Device Management Overview 
8  
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Introduction to iDigi

iDigi Platform

The iDigi Platform is a Machine Relationship Management (MRM) delivery 
platform, the next step in the machine-to-machine (M2M) technology 
revolution. It supplies the fundamental components for enterprise 
applications and remote machine assets (devices) to easily work together. 
The iDigi Platform is based on industry-standard protocols and open 
technology for customers and partners to extend specifically for their 
industry. The result is faster to market and the lowest cost of ownership.

The iDigi Platform is an on-demand service. There are no infrastructure 
requirements. Remote devices and enterprise business applications 
connect to the iDigi Platform via standards-based Web Services. You will 
be able to simply connect to the iDigi Platform and get to work.

Drop-in networking

As an integral part of the Drop-in Networking strategy, the Python 
development environment is incorporated by Digi into each ConnectPort 
X4 Gateway. Digi's integration of the open Python scripting language 
provides customers a truly open standard for complete control over 
connections to devices, manipulation of data, and event-based actions. For 
more information about the Digi Python custom development platform, visit 
our Python portal today at:

http://www.digi.com/technology/drop-in-networking/pdr.jsp

iDigi Dia
Also available is a device connection application called iDigi Dia (Device 
Integration Application). iDigi Dia software runs on the Digi family of 
gateway devices. Dia simplifies developing custom applications for remote 
monitoring and sensor networking. Dia is written in the Python 
programming language and can easily be extended to accommodate 
additional requirements. Dia can be executed on a PC for prototyping when 
a suitable Python 2.4 interpreter is available.
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Set up your iDigi Professional Development Kit 

Step 1: Create an account on iDigi.com

To get started, set up an account on the iDigi Platform as follows. 

1. Navigate to http://www.idigi.com.

2. Click on the iDigi Platform Login Login button.
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3. If you already have an account enter your user credentials in the User 
Name and Password fields, then click the Log on button. For new 
users, click on the “Are you a new user" link and create your account. 

�
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Step 2: Set up the ConnectPort X4 gateway 

Connect and power on the ConnectPort X4 
1. Attach the antenna to the ConnectPort X4 gateway.

2. Connect an Ethernet cable from the ConnectPort X4 gateway to your 
hub or switch that provides access to the Internet.

3. Connect the power supply to the ConnectPort X4 gateway and connect 
the power supply to an outlet.

Note: Note (International version only): Connect the power supply to 
a power cable (not included), and the power cable to an outlet.

4. Use the downloaded Digi Device Discovery application to find the 
ConnectPort X4 gateway on your network.

Note: This is a sample IP address. Your IP address will be based upon 
your network.
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5. Double click on the ConnectPort X4 entry in the Digi Device Discovery 
Tool to bring up the Web UI.  

�
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Add the ConnectPort X4 Gateway to your iDigi device list 
To add the ConnectPort X4 to the device list, follow these steps.

1. Log into iDigi (www.idigi.com) using the username and password you 
just created. 

2. Select the Devices link in the Left Navigation Bar.

3. Click the button to bring up the Add Devices applet.  The Add 
Devices applet will discover the Digi devices on your network and the 
ConnectPort X4 gateway should appear in the list.  

4. Select the ConnectPort X4 and click the OK button. 

Note: If you cannot discover you device see Appendix A: 
Troubleshooting.
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5. Ensure your device is now displayed in the devices list as shown below:
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Step 3: Set up the XBIB-R-DEV RS232 Interface Board

1. Install the XBee module with the pigtail antenna on the XBIB-R-DEV 
RS232 Interface Board.

2. Connect the power supply cable into the XBIB-R-DEV RS232 Interface 
Board. 

3. Plug the power supply into an outlet.
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4.  Wait 10 seconds then click the Refresh button on the ConnectPort X4 
Web page. Once the XBIB-R-DEV RS232 Interface Board attaches to 
the ConnectPort X4 your XBee network devices list should be updated 
as shown below.   
 17



Step 4: Set up the XBIB-U-DEV USB Interface Board

1. Install the XBee module on the XBIB-U-DEV USB Interface Board.

2. Attach antenna to the XBee module.

3. Download the USB Driver from the Digi support site at:   
http://www.digi.com/support/productdetl.jsp?pid=3992&osvid=0&tp=1. 

Select the "PKG-U USB Drivers for Windows 98 SE - XP" entry in the 
General Drivers section. 

4. Unzip the USB Driver package to a directory of your choice and note 
that location.

5. Connect the XBee module to the PC using a USB cable. The Found 
New Hardware Wizard dialog box is displayed.
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To attach the XBIB-U-DEV USB Interface Board to the PC, two drivers 
must be installed by following these steps: 

1. On the first screen, select “No, not this time” when asked to allow 
Windows Update to search for software in order to save time in the 
installation process.

2. Select “Install from a list or specific location (Advanced); then click 
Next.
 19



3. Check “Include this location in the search” and browse to the folder 
where you extracted the drivers to in Step 1, then click Next. .

4. A Hardware Installation warning dialog is displayed, click Continue 
Anyway.

5. Click Finish.
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You are then prompted to install the second driver, the virtual COM port 
driver. 

6. To install the COM port driver repeat steps 2 through 5 using the 
following screenshots as a reference.
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Wait 10 seconds then click the Refresh button on the ConnectPort X4 Web 
page. Once the XBIB-R-DEV RS232 Interface Board attaches to the 
ConnectPort X4 your XBee network devices list should be updated as 
shown below. 
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Step 5: Set up XBee Wall Router 

1. Plug the XBee Wall Router into an outlet.

2. Wait 10 seconds then click the Refresh button on the ConnectPort X4 
Web page. Once the XBee Wall Router attaches to the ConnectPort X4 
your XBee network devices list should be updated as shown below.

Temperature 
sensor 
(internal)

Associate/
Power LED

Light sensor
Reset/Ident 
button
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3. All 3 XBee nodes should have been discovered by the ConnectPort X4 
as shown below.
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System diagram
Your iDigi Professional Development Kit is now set up as shown below:

ConnectPort X4 Gateway

XBee Wall Router

XBIB-R-DEV RS232 
Development Board

XBIB-U-DEV USB 
Development Board
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View the XBee Nodes via the ConnectPort X4 using the Web Interface
The three XBee devices in this kit are known as nodes. In this task you will 
see a network view of the nodes from the ConnectPort X4 Web UI. 

1. First, return to the home page of the ConnectPort X4 Web UI as shown 
below:

2. From the menu on the left side, select 
Administration > System Information.

3. In the list of Configuration links on the Home page, click XBee 
Network.
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4. The XBee Network page is displayed. It shows several settings for the 
XBee module inside the ConnectPort X4, followed by a network view of 
the XBee devices, or nodes. Initially, this page will not show any nodes 
aside from the PAN coordinator (the ConnectPort X4).

To discover nodes:

• Check Clear list before device discovery checkbox. This check 
box clears any previously read and displayed network information 
from the ConnectPort X4’s cache before the device discovery oper-
ation occurs. 

• Click the Refresh button.

In the Node Type column, the XBee module attached to the gateway is 
listed as the coordinator. The XBee Interface boards and XBee Wall 
Router are listed as routers. 
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Step 6: Install the Digi Python Development Framework
Run the Digi Python Development Environment installation wizard that you 
have previously downloaded. Follow the steps in the wizard to complete 
the installation.  
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Step 7: Run the Digi ESP  
After the installation completes, run the Digi ESP program, select 
Start > Programs > Digi > iDigi > Digi ESP or double-click on the desktop 
icon "Digi ESP for Python Development.”

1. The Digi ESP for Python Development needs to build a workspace; you 
will be prompted with a dialog similar to the one below. Check "Use this 
as the default and do not ask again", then click OK.

2. After a few moments the Digi ESP for Python Development Welcome 
Screen and the Package Manager Welcome Page will be displayed 
(see below). 
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3. Close the Package Manager Screen, and return to the Digi ESP for 
Python Development Welcome Screen.  Next, close the Welcome 
Screen to reveal the Workbench (as shown below):

Note: To close the Welcome Screen click the white “X” located in the 
“Welcome” tab in the upper left side of the screen. 
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4. You will need to add the ConnectPort X4 to the list of devices that the 
ESP for Python Development environment interfaces with, this is done 
using the Device Manager. Navigate to the Device Manager by 
selecting the following menu option: Device Options > Device 
Manager.

5. Let the Device Manager discover the ConnectPort X4 automatically by 
clicking the Discover Devices button (circled in red above). The Device 
Manager will ask you to determine where the search will be performed; 
in this case select the "Local area network / USB devices" option, and 
then click OK to continue.
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6. The Device Discovery should come up and display the ConnectPort X4 
as shown below.

7. Select the ConnectPort X4, and then click the Create Configuration 
button.
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8. The ConnectPort X4 will be added to the list of devices under the Digi 
Device entry as shown below:

9. The ConnectPort X4 configuration is not quite complete. The iDigi 
Connection tab information needs to be completed. Click the “iDigi 
Connection” tab.
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10.Within the iDigi Connection tab dialog box (pictured below), fill in the 
Device ID and your iDigi Username and Password.

11. The Device ID of the ConnectPort X4 is displayed on its Web UI Home 
page as shown below.
 35



12.After you enter the Device ID and your iDigi Username and Password, 
click Apply.

13.Before exiting the Device Manager, click Set Current.

14.The Device Manager will now have the following configuration:
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15.Now you are ready to build your first project.  Do this by selecting the 
following menu option: File > New > iDigi Dia Sample Project. 
This will display the list of sample projects. Select the "iDigi 
Professional Development Kit", and then click Next.
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16.Select Python 2.4.3 in the Python settings Interpreter drop-down box, 
and then click Next.
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17.From the Remote Device selection dialog, select the "ConnectPort_X4" 
device, and then click Next.
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18.The Review dialog will be displayed summarizing the Project Options.  
Click Finish to create the Project.
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19.Your Workbench should look similar the following:

20.The XBee Device Manager entry, lists the three XBee devices 
contained in your Development Kit: two XBee Interface Boards and an 
XBee Wall Router. The XBee MAC address for each of these devices 
needs to be updated with the actual MAC addresses of the devices 
provided in the Development Kit.
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21.Use the Web UI of the ConnectPort X4 to retrieve the XBee MAC 
addresses of all the devices. Open the Home page and select the 
"XBee Network" link. A screen similar to the following should appear:
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22.On the Workbench, click on the "XBib development board [xbib0]" entry 
and you will see a screen similar to the following:
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23.Fill in the MAC Address field with the Extended Address entry for that 
device from the Web UI (as shown below):

Note: When entering MAC Addresses ensure that only the 
corresponding Extended Address (from Step 21) for each device 
is entered into each of the MAC Address fields below. 

24.Repeat this process and fill in the XBee MAC Addresses for the other 
Interface Board and the XBee Wall Router.
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25.Now that all three XBee MAC Addresses have been configured, the 
Project is ready to launch.

26.Click the Run  button to launch your 'iDigi_pro_devit’ Project. Then 
select the "Remote iDigi Dia" option and click OK to continue.

27.You will see a dialog similar to the following. Click OK to launch the 
Project.
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28.The Source View at the bottom of the Workbench Screen will display 
status messages as the:
Building of the Project, 
Loading the Project onto the ConnectPort X4, 
Rebooting the ConnectPort X4, 
and finally the running of the Project on the ConnectPort X4 all take 
place.

29.The Workbench will now display the "Dia Web Presentation" tab, and 
your screen will look similar to the following:
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Now for a brief overview of the functionality of this demo.

Each of the XBIB Interface Boards has 4 push buttons labeled: SW1, SW2, 
SW3, and SW4.

Each of the XBIB Interface Boards has 4 Amber LEDs labeled: LED1, 
LED2, LED3, and LED4 (LED4 is not used during this demonstration and 
will be kept turned ON).

Button Pushing Demonstration

When one of the push button switches (labeled SW1, SW2, or SW3) is 
pushed down for about one second, the corresponding LED on the other 
XBIB Interface Board will toggle either ON/OFF (and vice versa).

Push Button SW4 has different functionality.  It toggles the state of the 
LED1, LED2, or LED3 on the other XBIB Interface Board.

Web Configuration Demonstration

The Refresh All button updates the Web Configuration Screen to provide 
the current configuration of the two XBIB Interface Boards.

The Apply Changes button pushes the LED configuration down to both of 
the XBIB Interface Boards. 

The following screen reflects a configuration where all of the 3 LEDs are 
turned OFF on both XBIB Interface Boards.
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Change several of the LED values to ON and then click Apply Changes 
(as shown below):
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Now, the first XBIB Interface Board will have LEDs 1 and 3 turned on, and 
the second XBIB Interface Board will have LED 2 turned on.
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30.When you are finished with the Project evaluation, simply click the 
Reboot Target button. You will see the following dialog box:

31.Select the ConnectPort_X4 entry, and then click OK.
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32.Be sure to check out the extensive online Help. Select the following 
menu option: Help > Help Contents, in order to display the Digi ESP 
online Help.

33. If you would like to customize the Workbench, go to the following menu: 
Window > Show View.

34.To reset the Workbench view (to appear as shown in Step 29) select the 
following menu option: Window > Reset Perspective.
 51



Appendix A: Troubleshooting

Manually discovering you ConnectPort X4 

If the ConnectPort X4 is not discovered, you can add it manually by clicking 
the Add Manually >> button shown below.  Please note that the MAC 
address label is located on the bottom of the gateway. 
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Configure your ConnectPort X4 to connect to iDigi
To configure your ConnectPort X4 Gateway and connect to the iDigi 
Platform, follow these steps:

1. Switch back to the Web UI for your ConnectPort X4 and select Remote 
Management from the Configuration section.

2. Enter the URL of the iDigi Platform (developer.idigi.com). You can find 
this URL from the iDigi Platform user portal screen header near the top 
of the screen under About |Log off.

3. Click the check box labeled “Automatically reconnect to the server after 
being disconnected.”
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